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About This Book

WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily
harm or loss of life.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in damage
to equipment or loss of information.

NOTE: Text set off in this manner provides important supplemental information.
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1 Introduction

HP thin clients with Microsoft Windows CE are easy to deploy, manage, and secure, and include
powerful features for mainstream business use.

● Easy to deploy

◦ Setup Wizard for easy configuration

◦ Familiar explorer shell that resembles Windows desktop

◦ Altiris Deployment Server

◦ HP Device Manager

◦ HP ThinState Capture

● Easy to manage

◦ Registry import tool

◦ Can update to the latest image directly from HP

◦ Can return to factory settings by pressing F9

● Easy to secure

◦ Can disable USB mass storage

◦ Can lock down user interface with HP ThinConnect

◦ Secure default Guest account

◦ More secure operating system

HP provides this client “ready to go” out of the box to meet most common customer requirements. You
may want to add/remove features, lock down the user interface, etc. This guide will introduce you to
the many features of this client and show you how to customize the client to your needs.

This guide provides the network administrator with instructions for local and remote configuration of the
CE-based terminal. Typically, a terminal is configured locally then used as a template for other
terminals, which are then configured using remote administration tools.
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Image Updates
HP provides periodic updates to the image for thin clients. Check the HP support site for important
documentation that provides specific information for your image version. You can find support
documentation at:

http://welcome.hp.com/country/us/en/support.html.

For the latest version of the HP thin client Microsoft Windows CE image, visit:

http://h18004.www1.hp.com/support/files/thinclients/us/index.html.

Setup Wizard
The HP Microsoft Windows CE images include a Setup Wizard, which provides a simplified, easy-to-
follow method to configure a thin client. The Setup Wizard launches after you unbundle the image. The
Setup Wizard launches the first time after either the thin client has either been reset to factory defaults
or a new software image has been loaded on the unit.

NOTE: There is a 20-second delay after the Setup Wizard launches. If you do not click Next before
the timer expires, the thin clients loads the default settings.
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2 The Desktop

The t5540 and t5550 thin clients with Microsoft Windows CE use an Explorer shell (desktop) that
resembles the typical Windows desktop to make it look familiar and easy to use. The desktop includes
a taskbar, Start menu, shortcut icons, and a background image.

NOTE: The taskbar and the Start menu are hidden by default.
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Display
To change the display settings, right-click on the desktop and select Properties. You can change the
following:

● background image

● appearance

● resolution and color quality settings

● screen saver

NOTE: You must reboot for changes to the display settings to take effect. If you do not know if your
monitor supports a setting, click the Test button on the Display Properties Settings tab.

For more information about display settings, see Display on page 33 in the Control Panel

chapter.

Taskbar
Move the pointer to the bottom of the screen to display the taskbar. The taskbar is hidden by default to
provide a clean ICA/RDP connection experience.

The taskbar provides access to system software. The taskbar includes:

● Start button

● active task buttons - currently running programs

● notification area - the system tray

To configure the thin client to show the taskbar:

1. Right-click on the taskbar.

2. Select Properties.

3. Clear the Auto hide check box.
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Start Menu
To open the Start menu, click the Start button on the taskbar. The Start menu provides access to
software and settings, allows you to run commands, and allows you to shut down the system.

Icons
The icons on the desktop provide shortcuts to software and connections. To launch a program from the
desktop, double-click the respective icon.

You can add icons for connections by right-clicking on the connection icon in the HP Connection for
Citrix software window and selecting Send to Desktop. For more information, see HP Connections
for Citrix Software on page 77 in Chapter 5.

NOTE: Windows CE architecture does not allow you to change the properties of programs from
desktop shortcuts. You can only change property values for the shortcut itself from the desktop.

Start Menu 5



3 HP ThinConnect

HP ThinConnect allows you to:

● Manage user accounts.

● Add, edit, and delete connections.

◦ Terminal emulation

◦ Microsoft Remote Desktop Client (RDP) connections

◦ Internet Explorer

◦ Citrix ICA connections

◦ VMware View client

● Assign connections to users.

The main HP ThinConnect window allows you to perform actions for only the current user. To assign
connections to other users, use the HP ThinConnect Advanced window. For more information about the
Advanced window, see Advanced Window on page 7.

You can access HP ThinConnect by clicking Start > Programs > HP ThinConnect.

NOTE: You must close all active connections to use the following buttons: Add, Delete, Edit,
Advanced, Exit.
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The HP ThinConnect window includes the following features:

● Connection display area: Lists all connections assigned to the user currently logged on to the
terminal. For each connection, the display shows the name, type, and status of the connection.

● Connect: Click to activate a selected connection.

● Exit: Click to exit HP ThinConnect. The OK button performs the same function.

● Control Panel: Click to access the Control Panel. This feature requires appropriate permissions.

● Add: Click to create a new connection and add it to the list of connections assigned to the user
currently logged on to the terminal. You can assign the new connection to other users in the
Advanced window. For more information, see Adding Connections on page 13.

● Delete: Click to delete a selected connection. The connection is deleted from the list of
connections available to all users, not just the user currently logged on to the terminal. For more
information, see Deleting Connections on page 14.

● Edit: Click to edit the selected connection. For more information, see Editing Connections
on page 13.

● Advanced: Click to access the Advanced window, where you can configure and assign
connections and configure the terminal user interface. For more information, see Advanced
Window on page 7.

● Help: Click to access help.

Advanced Window
You can access the Advanced window by clicking the Advanced button in HP ThinConnect. You must
log in with Administrator permissions or with the “User may add, edit, or delete connections”
permission to access the Advanced window. The Advanced window allows you to configure and
assign connections, set up user security accounts, and configure the user interface for the terminal.

CAUTION: Click either OK button to save changes and close the Advanced window. Click the X
button or Cancel to exit without saving changes.
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Creating User Accounts
You can set up terminal operator user accounts in the Security window, which you can access either
from the ThinConnect Advanced window or from Control Panel.

The system comes with three default accounts:

● Administrator

● Guest

● User

You can use the default accounts as templates for new accounts. You can modify the default Guest and
User accounts.

The Users tab lists all operator accounts and shows which accounts are set up with Administrator
security permissions and which accounts are enabled.

To create a new user account:

1. In HP ThinConnect, click Advanced.

2. On the Assign Connections tab, click Security. This takes you to the Control Panel Security
window.
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3. Select the Users tab, and then click Add to create a new user account.
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4. On the General tab, type a name for the new user account in the Name box. Valid characters
for the Name box include: A - Z, a - z, 0 - 9. (.)&^%$#!~‘’{}_-. Maximum length is 20 characters.

5. Type a password for the new user in the Password box.

6. Retype the password in the Confirm Password box.

7. To enable the user account, clear the Account is disabled check box.

8. To assign the same permissions to the new account that are assigned to an existing account, click
Set from Template.
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a. In the Based on list, select the account to use as a template.

b. Click OK to save your settings and return to the Add New User window.

c. To add another user, click Add another user. This option allows you to quickly add new
users.

9. To select permissions for the new account, select the Permissions tab on the Add New User
window.
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a. Select the items in the permissions list that you want to allow the user to access. If the user is
an Administrator, select User is Administrator to provide full access. If you select User is
Administrator, you cannot select or clear items in the list.

b. To save your settings and add another user, click Add another user.

or

Click OK to save your settings.

10. Click OK when you are finished adding users.

11. If you want to modify or delete user accounts, select the account, and then click Modify or
Delete.

12. Click OK at the top of the window when you are done adding or modify user accounts.

Connections
You can add, edit, or delete connections in HP ThinConnect and in the Advanced window. Add
connections as follows:

● Use HP ThinConnect to create and assign connections to the user currently logged on to the
terminal.

● Use the Advanced window to assign the connection to other users.
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Adding Connections

To add a connection in HP ThinConnect:

1. In HP ThinConnect, click Add.

2. In the Choose type dialog box, select the type of connection you want to create, and then click
OK. A Wizard or setup dialog for the connection type is displayed.

3. Follow the on-screen instructions in the Wizard or setup dialog to add the connection to the user’s
connections list and to the list of available connections that you can assign to other users in the
Advanced window.

NOTE: If you create a connection in HP Connections for Citrix Software, the connection is also
displayed in HP ThinConnect. Similarly, connections created in HP ThinConnect are also displayed in
HP Connections for Citrix Software.

Editing Connections

To edit a connection in HP ThinConnect:

▲ Select the connection, and then click Edit. Make the appropriate changes in the Wizard or setup
dialog.

NOTE: The following image illustrates the Edit Connection window for an RDP connection. The screen
varies based upon the type of connection you edit.
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NOTE: Renaming a connection effectively deletes it from all user accounts.

Deleting Connections

To delete a connection in HP ThinConnect:

▲ Select the connection, and then click Delete. The connection is deleted from all user connection
lists.

Assigning Connections to Users

Assign and configure connections for users in the Advanced window of HP ThinConnect.

Assign Connections Tab

The Assign Connections tab allows you to assign connections to users. This tab contains the
following features:
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● User: This list includes all users accounts associated with the system. To configure connections for
a user, select the user from the list.

● Security: Allows you to access the Security window, where you can create and configure user
accounts. This button opens the same window as selecting Security from Control Panel.

● Available connections: On the left side of the window, this panel shows all available
connections that you can assign to users. The columns in this panel include:

◦ Name: Shows the name of the connection assigned when the connection was created.

◦ Type: Shows the type of connection.

● Add: Click to create a new connection and add it to the Available connections list. When
you click this button, a connection type list is displayed. When you select a connection type to add
and click OK, a wizard opens that allows you to configure connections.

● Delete: Select a connection in the Available connections list, and then click this button to
delete the connection. Deleting a connection here also deletes the connection from the list of
connections assigned to all users.

● Edit: Select a connection in the Available connections list, and then click this button to edit the
connection.

● Connections for [user]: On the right side of the window, this panel shows the connections
assigned to the user displayed in the User box.

◦ Name: Shows the name of the connection assigned to the user.

◦ Type: Shows the type of connection.

◦ Primary: Designates a connection as either primary or secondary. Yes indicates a primary
connection. Click on the column value to change the setting. You cannot change the first
connection in the list to secondary.
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◦ Auto: Determines whether the system automatically connects when HP ThinConnect starts up.
Yes indicates the system will automatically connect. Click on the column value to change the
setting. NOTE: You must configure HP ThinConnect to auto start for this setting to function
properly. To configure HP ThinConnect to automatically start up, see Auto Starting HP
ThinConnect on page 18.

◦ Persistent: Determines whether the system will attempt to reconnect when a connection
fails. Yes indicates the system will automatically attempt to reconnect. Click on the column
value to change the setting.

● OK: Click to save changes and exit the Advanced window.

● Cancel: Click to cancel unsaved changes and exit the Advanced window.

● Apply: Click to save changes.

Assigning Connections

Once you have created a connection, you can assign it to users in the Advanced window.

1. In HP ThinConnect, click Advanced.

2. On the Assign Connections tab, select the appropriate user from the User list.

3. Double-click the connection in the Available connections list, or select the connection and click
the right arrow. The connection is copied to the Connections for [user] list.

4. Click Apply to save the updated list of connections for the user.

Designating Connections as Primary or Secondary

You can designate connections as primary or secondary in the Advanced window. A primary
connection is the first attempted in a group of connections. If a primary connection fails, the system
attempts failover secondary connections in the order they are listed. You can configure more than one
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primary connection, each of which can have several secondary connections associated with it.
Secondary connections are optional.

To designate a connection as primary or secondary:

1. In the HP ThinConnect window, click Advanced.

2. On the Assign Connections tab, select the appropriate user from the User list.

3. Select the connection from the user’s connection list that you want to make primary.

4. In the Primary column, click on the column value to change it. Yes means the connection is a
primary connection. The first entry in the list must be primary.

5. If you want to assign a secondary connection, select the connection and change the value in the
Primary column to No. The connection becomes secondary to the first primary connection
directly above it in the list.

6. To arrange the order of connections, select a connection and click the up and down arrows.
Secondary connections are associated with the first primary connection above them in the list.

7. Click Apply.

NOTE: Every secondary connection must have a primary connection listed above it.

Enabling Automatic Connection and Reconnection

In the Advanced window, you can set up primary connections assigned to users to automatically
connect at boot up and to reconnect if disconnected. Automatic connection requires that you configure
HP ThinConnect to start automatically. For more information, see Auto Starting HP ThinConnect
on page 18.

To enable automatic connection and reconnection:

1. In the HP ThinConnect window, click Advanced.

2. On the Assign Connections tab, select the appropriate user from the User list.

3. Select the primary connection in the user’s connection list that you want to automatically connect.
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4. In the Auto column, if the entry for the selected connection is No, click on No to change it to
Yes.

5. Select the connection in the user’s connection list that you want to make automatically reconnect.

NOTE: You can set only primary connections to automatically reconnect.

6. In the Persistent column, if the entry for the selected connection is No, click on No to change it
to Yes.

7. To arrange the order of connections, select a connection and click the up and down arrows.
Secondary connections are associated with the first primary connection above them in the list.

8. Click Apply to save your changes.

NOTE: You can set only primary connections to automatically connect when HP ThinConnect is
launched.

Configuring the User Interface
The Global UI tab on the Advanced window allows you to configure HP ThinConnect to start
automatically and allows you to set up Kiosk mode.

Auto Starting HP ThinConnect

You can enable automatic log on, which causes HP ThinConnect to start automatically when the user
logs in to Windows.

To auto start HP ThinConnect:

1. In the HP ThinConnect window, click Advanced.

2. Click the Global UI tab.
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3. Select Auto start HP ThinConnect when logging into Windows.

4. Click Apply to save changes.

Setting the Terminal to Kiosk Mode

Kiosk mode limits the terminal’s functionality by hiding the desktop icons and limiting the Start menu to
Shut Down only. There are also Kiosk mode options for hiding the task bar and hiding HP
ThinConnect.

NOTE: Before setting a terminal to run in Kiosk mode, you must define a user and create a
connection. For more information, refer to “Creating user accounts” and “Connections”.

The preview display on the right side of the screen shows you how the user interface will appear when
you select the various check boxes on the left side of the tab.

To set the terminal to run in Kiosk mode:

1. Create the necessary connection.

2. On the HP ThinConnect window, click Advanced.

3. Click the Global UI tab.

4. Select the Auto start HP ThinConnect when logging into Windows check box. This
makes the Kiosk mode option available.

5. Select Kiosk mode. Two more check boxes become available as options.

6. To further lock down the terminal in Kiosk mode by hiding the task bar at the bottom of the
desktop, select the Hide connection task bar check box. You must select the automatic logon
feature to gain access to this feature.
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7. To further lock down the terminal in Kiosk mode by hiding the user interface to connection settings,
select Hide the User interface not allowing changes to connection settings. You must
select the automatic logon feature to gain access to this feature.

8. Click Apply to save your changes, or click OK to save your changes and exit the Advanced
window.

9. Log off the user for all changes to take effect.

Enabling Automatic Log On and Keyboard Functions
The Security window in Control Panel allows you to enable automatic log on which bypasses a user’s
password requirement when logging on to the system.

To enable automatic log on:

1. On the HP ThinConnect window, click Advanced.
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2. Click Security. The System Statistics area shows information about system users and
connections.

3. On the System tab, select Automatic Log On so the user does not have to enter a password
to log in to the local machine. You can set up automatic log on for one user per terminal. The
default is no password. You must select Automatic Log On to gain access to the Single
Button Log On check box and the Account list.

4. If you want to lock the terminal when pressing Ctrl+Alt+Delete, select Lock screen when
pressing Ctrl+Alt+Delete. This feature allows users to quickly lock their terminal and prevent
unauthorized access. When the terminal is locked, press Ctrl+Alt+Delete again to type your
password to regain access to the terminal.

5. If you want to activate the single button connect feature, select Single Button Log On. This
feature invokes a dialog box that requires the terminal operator to press Enter or click the Logon
button on the dialog box to log in. If someone other than the auto logon user wants to log onto the
terminal, press Esc or Alt+F4.

6. From the Account list, select the account that the system will use to log on the terminal operator.

7. Select Enable Reset Hotkey to allow the terminal to be reset to factory defaults (registry and
shortcuts) by pressing and holding F9 key during boot.

CAUTION: If you disable the F9 reset function and then change monitors or change display
settings resulting in your monitor becoming unable to display, the only way to recover the client
will be to reflash it.

8. Click OK at the top of the window to save your changes.
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Switching to a Different User
To switch to a different user when booting:

1. Press the power button to start the system.

2. Press Esc or Alt+F4 before the automatic logon countdown completes.

3. Log on as the user of your choice.
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4 Control Panel

This chapter provides an overview of the programs in the Control Panel and provides step-by-step
instructions to perform certain tasks. You can use many of the programs for local administration, while
you use others, such as DHCP Options and SNMP, for remote administration.

To open the Control Panel:

● From the desktop, select Start > Settings > Control Panel.

or

● From the HP ThinConnect window, click the Control Panel button.

NOTE: The LPD Control program is available only on terminals equipped with a serial port.
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802.1x Wired Client
The 802.1x Wired Client provides an authentication mechanism for attaching to a LAN. It provides
EAP-TLS support, as well as support for importing .PFX certificates in the Certificates applet.

NOTE: After the applet has run for the first time, the client icon appears in the system tray.
Subsequent applet starts need to be run from the system tray icon.

1. Click Setting to configure the EAP Methods, Verify Certificates, and DHCP Option.

2. Select EAP Methods and click Setting.

NOTE: A Certificate must first be imported through the Certificates applet in Control Panel.

3. Select the Certificate, and then click OK.
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4. Select Verify Certificates and click Setting.

5. Select the Certificates, and then click OK.

6. Select DHCP Option, if the IP is to be assigned by the server, and then click OK.
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7. Once the 802.1x Wired configuration is complete, click Connect.

Confirmation of successful authentication appears.
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Accessibility

The Accessibility dialog box allows you to configure the terminal with 508 Accessibility features.
Accessibility options are available for the keyboard, sound, display, and mouse.

● Keyboard: Allows you to enable StickyKeys, which lets you use the Shift, Ctrl, and Alt keys
pressing one key at a time rather than holding them all down simultaneously. You can also enable
ToggleKeys to hear tones when pressing the Caps Lock, Num Lock, and Scroll Lock keys.

● Sound: Allows you to enable SoundSentry, which causes Windows to generate visual warnings
when the system makes a sound.

● Display: Allows you to enable High Contrast, which causes Windows to use colors and fonts
designed for easy reading.

● Mouse: Allows you to enable MouseKeys, which lets you control the pointer with the numeric
keypad on the keyboard.

● General: Allows you to automatically turn off accessibility features after a set amount of idle time.
You can also enable the notification feature, which causes Windows to make a sound when you
turn a feature on or off.

Accessibility
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Boot Settings
The Boot Settings dialog box allows you to configure the thin client boot order.

Boot Device Order: Select to enable the device to which the thin client boots. Use the up and down
arrows to the left of the list to change the position of a selected device.

NOTE: You cannot clear (disable) ATA Flash.

Enable F12 Network Boot: Select to enable the ability to boot the client using a network drive.
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Certificates
The Certificates dialog box allows you to import, store, and view security certificates. Certificates and
certificate authorities ensure that an SSL connection is made to the intended secure server. Certificate
information is exchanged between the terminal browser and the secure server when establishing a
connection. If a trusted certificate authority can authenticate the certificate, the secure page is
automatically displayed. A private key is also used to encrypt data over an SSL connection.

To import a certificate or private key:

1. Select the type of certificate you would like to import from the drop-down list.

● Trusted Authorities are digital certificates issued by certification authorities. The Windows CE
browser comes with a pre-defined list of trusted certification authorities that include Equifax,
Thwarte, Entrust, GlobalSign, GTE, and others.

● My Certificates are your personal digital certificates.

● Other Authorities are intermediate certificate authorities. No intermediate authorities are
loaded by default.

2. Click Import, select the location source of the certificate or key, and then click OK.

● From a File allows you to import a certificate or key from any mapped drive. Browse to the
certificate or key and select it, or select the Type and type the name of the certificate or key
in the Name box.

● From a Smart Card allows you to import a certificate from a Smart Card. Make sure the
Smart Card is inserted and select a Reader from the list. The radio button is active only if a
smart card is inserted.

● Friendly name allows you to rename a certificate that you import.

3. Click OK.
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Date/Time
The Date/Time Properties dialog box allows you to set the date and current time, select the appropriate
time zone, and enable automatic clock adjustment for daylight savings time for the terminal.

▲ Select the appropriate date and time information, and then click Apply.

DHCP Options
The DHCP Options page allows you to configure the thin client with tags (see the Codes column in the
illustration below) that identify the FTP location of the update image that the client retrieves from the FTP
server. If you set these tags, the Value column will be populated automatically with the FTP server
location. Each time the system boots, it will check these fields for a file server (or FTP server) and will
look for system updates. Use the Power Settings utility to schedule wakeup and shutdown times to make
sure the system is updated regularly.

NOTE:  For information about resetting thin client settings to factory defaults, see the System

on page 63 section later in this chapter.
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To change tag codes:

1. Double-click on the name of the option to change. A dialog box will be displayed with a list of all
valid options.

2. Select the appropriate value from the list, and then click OK.

To add a custom option:

1. To open the DHCP configuration snap-in, click Control Panel > Administrative Tools >
DHCP.

2. Right-click the root node and select Set predefined options.

3. Click Add.

4. Configure the following options:

● Option type: String

● Option name: <name>

● Code: <DHCP Option Code>

5. Click OK.

To make an option active within scope:

1. Expand the scope tree.

2. Right-click Scope Options and select Configure Options.
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3. Select option(s) to be sent and set the value

● Select option in list as <DHCP Option Code> <name>.

● Set value as string <code value> that you want sent over DHCP.

4. Click OK.

Dialing

The Dialing Properties dialog box allows you to:

● Add or select a dialing location.

● Configure dial-up settings for the selected location. Local settings include the area code, county/
region code, and tone or pulse dialing.

● Disable call waiting.

● Set up dialing patterns for local, long distance, and international calls.

To add a dialing location:

1. Select or add a When dialing from location and type the local settings for the location.

2. Click OK after entering the information.
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To configure the system to use an area code for local calls:

1. Click Dialing Patterns.

2. In the For Local calls dial box, add an F before the G. For example, F,G will dial the area
code, then 7-digit phone number.

Display

The Display Properties dialog box allows you to configure the background image, appearance scheme,
screen resolution, color quality, refresh frequency, and screen saver.

NOTE: You can also access the Display Properties dialog box by right-clicking on the desktop and
selecting Properties.

Reboot the terminal for display property changes to take effect.

The Background tab allows you to set the background image that appears on your monitor. You can
use a background image that is any of the following formats:

● bmp

● gif

● jpeg

Save background image files in the Hard Drive folder to assure the client can find them after a
reboot.

The Appearance tab allows you to set the Windows CE color scheme.
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The Settings tab includes a Test button that you can use to test the resolution and refresh settings. If
you select settings your monitor does not support and you do not test updated settings, the next time
you reboot, your display will not work and you must press F9 to reset to defaults.

In the Screen Saver tab you can set up password protection as well as configure the following screen
saver options:

● no screen saver

● turn off monitor

● floating image

● tiled image

The following table lists the available screen resolutions, color quality settings, and refresh frequencies.
The default is 800x600x16 @ 60Hz.

Resolution/Color Wide Screen 60Hz 75Hz 85Hz

800x600x16  X X X

800x600x32  X X X

1024x768x16  X X X

1024x768x32  X X X

1280x720x16 X X   

1280x720x32 X X   

1280x768x16 X X   

1280x768x32 X X   

1280x1024x16  X X X

1280x1024x32  X X X

1360x768x16 X X   

1360x768x32 X X   

1440x900x16 X X   

1440x900x32 X X   

1600x1200x16  X   

1600x1200x32  X   

1680x1050x16 X X   

1680x1050x32 X X   

1920x1200x16 X X   

1920x1200x32 X X   

1920x1440x16  X   

1920x1440x32  X   
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Resolution/Color Wide Screen 60Hz 75Hz 85Hz

1920x1080x16  X   

1920x1080x32  X   

NOTE: If you set the display settings out of range, you must reset the terminal to factory defaults by
rebooting the terminal and holding down the F9 key until you see a window that says “Loading...” at
the bottom. Resetting the terminal to factory defaults erases all configuration settings and connections.
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Global ICA Client Settings
The Global ICA Client Settings dialog box allows you to configure ICA default client settings.

Keyboard Shortcuts

The Keyboard Shortcuts tab allows you to configure hot key combinations that you can use during
active ICA sessions. You can assign the hot keys used to perform a function by selecting the hot key
combinations from the list next to each function.

● Connection Status invokes a message about the status of the connection.

● Close Session disconnects the terminal from the server but does not actually close the session on
the server. The session will continue to run on the server until the terminal operator logs off.

● ESC performs the same function as the Esc key.

● CTRL+ALT+DEL invokes the terminal Security dialog box.

● CTRL+ESC calls up the Remote Task list on WinFrame servers, or opens the Start menu on
MetaFrame servers.

● ALT+ESC cycles the focus through the minimized icons.

● ALT+TAB cycles through open applications in sequential order.

● ALT+BACKTAB also cycles through open applications sequentially, but in the opposite direction.
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Preferences

The Preferences tab allows you to set color preferences during an ICA session.

The Preferences tab contains the following:

● Serial Number: Type the serial number of the ICA Client software exactly as it appears on the
serial number card. This is necessary when using the ICA Windows CE Client with certain
products, such as WinFrame Host/Terminal. It is not necessary for MetaFrame servers.

● Default Window Colors: Select the color option for the ICA client. If the ICA server does not
support the selected color option, then it defaults to 16-bit color.

● PNAgent: Select to enable PNAgent.

◦ Settings: Click to display a dialog box that allows you to type the URL of the PNAgent
server. You can use this server to remotely configure PNAgent settings. You can configure
ICA seamless settings is these screens.

◦ Force PNAgent on Reboot: Select to cause PNAgent to prompt you to log in every time
you reboot.

● Apply Windows key combinations: Select the option in which you want key combinations
to function.

◦ In full screen desktops only and On the remote desktop apply to the ICA session.

◦ On the local desktop applies to the local client.
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Server Location

The Server Location tab allows you to view/add Citrix servers on the network that have ICA
connections configured.

The Server Location tab contains the following:

● Server Group: Select whether the servers in the server address list belong to your Primary,
Backup 1, or Backup 2 group.

● Server address list: Lists the entered server locations.

● Add: Click to add a server address.

● Delete: Click to delete a server address.

● Rename Group: Click to rename the selected server group.

● Default List: Click to recall the previous server address list.

Firewall Settings

The Firewall Settings tab allows you to set up a firewall by placing a proxy server between a server
and a client.
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In the Proxy section, select a protocol from the list, and then type the proxy address and port.

In the SSL/TLS Relay section, type the relay address and port for the Socket Security Layer (SSL) or
Transport Layer Security (TLS) protocol.

If the firewall uses address remapping, you must configure the client to use the alternate address
returned by the data collector by selecting Use alternate address through firewalls. This is
necessary whether or not you are using a SOCKS or secure proxy server.

HP Easy Tools
The HP Easy Tools wizard helps you to create a thin client configuration. You can use this configuration
on a single thin client or deploy it to multiple thin clients with HP ThinState or HP Device Manager.

For more information, see the HP Easy Tools Administrator’s Guide at http://www.hp.com/support.
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HP Device Manager
HP Device Manager is enterprise-class thin client management software that allows customers to view
their thin client assets remotely and to manipulate those thin clients to meet the required business need.

Thin Client Management features include:

● Asset and inventory management

● Thin client settings and connection cloning

● Software updates

● Patch and client updates

● Remote control

● Remote power management

For more detailed information, please see the HP Device Manager User Manual or the HP Device
Manager Worldwide QuickSpec at http://www.hp.com.
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HP ThinState Capture

HP ThinState capture and deploy allows you to capture a full thin client image or system settings and
deploy them to other thin clients of the same model.

HP ThinState Capture

NOTE: The HP ThinState Capture tool is not a standalone tool and can only be accessed by the
administrator from within the thin client image.

Save all data on the USB flash drive on some other device prior to performing this procedure. The USB
flash drive will be formatted and all data will be lost.

ATTENTION: When deploying an image or settings from a “source” or “master” thin client to a
“target” thin client, please make sure that source/master and target thin clients have identical
hardware. This is applicable regardless of deployment method being used: HP ThinState Tools, Altiris
Deployment Solution, HP OpenView Client Configuration Manager, or any other deployment solution
being used.

The HP ThinState Capture tool is a simple wizard-based tool that you can use to capture an HP thin
client image or system settings that you can then deploy to another HP thin client of identical model and
hardware.

What do you need to have?

● An HP-approved USB drive key.

● An HP thin client CE unit that contains the latest HP provided image is optional.

Once you launch the ThinState Capture tool from within the Control Panel, you are presented with the
following screen.

HP ThinState Capture
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1. Click Next.

2. Connect a USB flash drive to the unit. The USB flash drive letter and size are displayed. The USB
flash drive must be greater in size than the on-board flash disk.

3. Choose whether you want to capture a full image or system settings. Click Capture.

4. Click Yes on the warning screen. The ThinState Capture tool formats and makes the USB flash
drive bootable. ThinState Capture reboots the system.

5. Follow the on-screen instructions.

You can now use the USB flash drive to deploy the captured image or system settings to another HP thin
client of the exact same model and hardware.
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HP ThinState Deploy

To perform a ThinState deployment:

1. Set the boot order in the F10 System BIOS to USB boot (if necessary).

2. Attach the USB flash drive to the thin client unit you wish to deploy the captured image or system
settings to, and then power on the unit.

3. Follow the on-screen instructions. You can deploy the captured image or settings in one of the
following ways:

● Upload to an FTP server or Windows file share

● Save to a USB flash drive

● Have the thin client host the settings or full image for other units to pick up using System
Update (If you are using this option, you do not need the USB flash drive.)

After you remove the USB flash drive and cycle power to the system, the image unbundles. Do not
interrupt or cycle power to the unit during this process.

You may use the captured image (flash.dd) found in the USB flash drive in combination with Altiris
Deployment Solution to remotely image multiple thin client units.

NOTE: You must use flash.ibr in conjunction with the HP ThinState Deploy utility (e.g., ibr.exe).
Flash.dd is not compatible with the Altiris rdeploy.exe or rdeployt.exe utilities. Please consult the HP
Compaq Thin Client Imaging Tool at: http://h20000.www2.hp.com/bc/docs/support/
SupportManual/c00485307/c00485307.pdf.

For more information about Altiris, see http://www.altiris.com/.

Internet Options

The Internet Settings dialog box allows you to configure Internet browser settings on the terminal.

Internet Options
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The Internet Settings dialog box includes the following tabs:

● General: Allows you to enter start and search pages, identify the Web browser type to
determine how Web pages are displayed, set the cache size, and clear cache and history.

● Connection: Allows you to select LAN or autodial connections and to configure proxy server
settings.

● Security: Allows you to specify Web sites that are trusted, restricted, and so on. Also allows you
configure ActiveX, scripting, and other advanced-type internet options.

● Privacy: Allows you to configure how the browser handles cookies.

● Advanced: Allows you to configure multiple internet options, including options for accessibility,
browsing, multimedia, and security.

● Popups: Allows you to configure how the browser handles pop-ups, including blocking,
notification when pop-ups are blocked, and exceptions that allow popups from specific sites.

● Other Options: Allows you to enable browser window resizing, enable favorites, and set the
font size.

NOTE: Due to CE architecture, proxy exceptions are not available.

Keyboard
The Keyboard Properties dialog box allows you to configure your keyboard.

Repeat delay determines how long you must hold down a key before its character starts repeating.

Repeat rate determines how quickly a character repeatedly is displayed on screen when the key is
held down.

If you are a legacy user, see Regional Settings on page 54 to change keyboard settings.
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Select Disable local Windows key combinations (e.g. ALT+TAB) to disable the passing of hot
keys to the terminal service server.

Select Boot time Num Lock state (On/Off) to enable Num Lock on the client.

LPD Control

The LPD Control dialog box allows you to set the terminal up as a line printer (print server).

To set the terminal up as a print server:

1. Select Enable Printer.

2. Type the Printer Name and Network Port.

3. Select the appropriate printer port from the list. If you select a COM port, you have the option of
configuring the serial port by clicking Configure and typing the appropriate parameters.

4. Select Send Form Feed if form feeds are necessary. Form feeds are primarily used with older
printer technology.

NOTE: Verify the terminal serial port is enabled in BIOS and in the Control Panel Port Lock window.
You must also set up the application server for LPD printing.

Modems
The Modem Settings dialog box allows you to access and modify settings for external modems.

LPD Control
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Refer to the device instructions that shipped with the modem, or located on the manufacturer Web site,
for listings of modem “AT” commands available for the modem.

Mouse

The Mouse Properties dialog box allows you to set the mouse double-click sensitivity for speed and
physical distance between clicks.

● Use the Double-Click tab to set the double-click sensitivity by double-clicking the grid icon, then
test the setting by double-clicking the test icon.

● Use the Button Configuration tab to configure for left-handed use.

● Use the Pointer Speed tab to configure how fast the mouse pointer moves on the screen based
on how the users moves the mouse.
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Network and Dial-up Connections

The Network and Dial-up Connections window allows you to configure connectivity between the
terminal and the Internet, a network, or a computer.

To make a new connection, double-click the Make New Connection icon, select the type of
connection you want to make, and then configure the connection.

Choose from the following connection types:

● Dial-up Connection

● Direct Connection

● VPN (PPTP)

● VPN (L2TP)

● Ethernet (PPPoE)

Dial-up Connection

You can use a dial-up modem with the thin client to access a dial-up server. This method provides two
ways to access the enterprise intranet:

● An enterprise dial-up server connects directly to the enterprise intranet.

● An Internet Service Provider (ISP) dial-up server provides access to the Internet, from which the thin
client must access an enterprise Point-to-Point Tunneling Protocol (PPTP) Virtual Private Network
(VPN) server that connects to the enterprise intranet.

NOTE: The dial-up server must be a Microsoft Remote Access Server or another server that supports
industry-standard protocols.

Direct Connection

This type of connection allows you to connect directly to another computer through the serial port on the
terminal.

NOTE: This option is available only to thin clients with serial ports.

Virtual Private Network (PPTP) Connection

Point-to-Point Tunneling Protocol (PPTP) is a network protocol that enables the secure transfer of data
between a remote client (in this case the thin client) and an enterprise server environment by creating a
VPN across TCP/IP-based data networks such as the Internet. It provides a password-protected path

Network and Dial-up Connections
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through the enterprise firewall to the enterprise server environment in which the network and session
services required by the thin client reside.

Access to the internet requires an Internet Service Provider (ISP). You may use any of the standard
means of connecting to the ISP, such as a dial-up modem, cable modem, or DSL modem.

You must first establish the connection to the ISP, before contacting the enterprise PPTP VPN server. This
includes dial-up access as well as direct access through the cable modem and DSL modem paths.

Virtual Private Network (L2TP) Connection

Layer Two Tunneling Protocol (L2TP) merges the Microsoft PPTP protocol with the Cisco Layer Two
Forwarding (L2F) protocol. L2TP is basically the same as PPTP; the primary difference is that L2TP
supports encryption.

PPP Over Ethernet (PPPoE) Connection

This is a connection from the thin client Ethernet port directly to the enterprise intranet. No additional
hardware is required.

In this configuration all network services may be used, including the enterprise DHCP server. A DHCP
server on the network may provide not only the terminal’s IP address, but also the location of the file
server containing the software updates.

Port Lock
The Port Lock dialog box allows you to enable or disable COM 1 ports, LPT ports, and USB mass
storage devices.

To enable a port, select the appropriate check box, and then click OK.

Power Settings
The Power Settings dialog box allows you to configure settings such as BIOS wake-up, shutdown,
power state after power failure, and alarm settings.
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BIOS Wakeup Alarm: Set the time of day the thin client wakes up. You must first reboot and then
shut down the unit for this feature to work.

Enable Wake On LAN: Select to enable the power in the client to be turned on by the network.

PWRON State After Power Fail: Select whether power is to be on/off or defaults to its former
state after a power failure.

Set Alarm: Select the day(s) that the thin client wakes up. You must first reboot and then shut down
the unit for this feature to take affect.
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Shutdown settings: Set the time of day the thin client is to shut down.

Printers

Printers

The Printers dialog box allows you to add local and network printer configurations and modify existing
printer configurations. This configuration enables the terminal to print from a server session to a local
printer.

NOTE: Windows CE is best suited for printing smaller documents.

The Printers dialog box contains an Add Network Printer icon, an Add Local Printer icon, an
Add RDP/ICA Printer icon, and an icon for each configured printer.

You can use Internet Printing Protocol (IPP) to print to network printers. IPP defines a standard protocol
for printing as well as managing print jobs.

NOTE: To avoid port conflicts, HP recommends using COM2 for IPP printing.
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Adding a Printer

To add a printer configuration from the Printers dialog box:

1. Double-click the Add Network Printer or Add Local Printer icon to invoke the Printer
Wizard, which allows you to configure a new printer.

2. In the first panel of the wizard, select the port that you want the printer to use, and then click
Next.
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3. In the next wizard panel, select the printer manufacturer and model, and then click Next.

CAUTION: It is critical that the model name entered in step 3 match EXACTLY the name of the
driver installed on the terminal server. If it does not, printing will fail.

4. Click Yes to print test page and share this printer, if desired, and then click Finish.

The configured printer now appears in the printer window.
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Setting up a Network Printer

1. Select Add Network Printer in the printer window.

2. Type the IP address or domain name in the field, and then click Next.
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3. Select the printer manufacturer and model, and then click Next.

4. Click Yes to print test page, if desired.

Modifying an Existing Printer Configuration

To modify an existing printer configuration in the Printers dialog box:

1. Double-click the desired printer icon or select the icon and click Properties. The Printer Properties
dialog box is displayed.

2. Make any necessary modifications, and then click OK to save.

Regional Settings

The Regional and Language Settings dialog box allows you to customize regional settings for the
terminal. You can change the way Windows CE displays numbers, currency amounts, times, and dates.
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The Regional Settings Properties dialog box includes the following tabs:

● Regional Settings: Allows you to select an input locale, which determines how some programs
format numbers, currency, time, and dates. The options available on the other tabs are determined
by the selected region.

Click Customize to configure the way Windows displays the following:

◦ Numbers

◦ Currency

◦ Time

◦ Date

● User Interface Language: Allows you to determine the language used for the menus, dialogs
and alerts. Only English is supported.

● Input Language: Allows you to select the keyboard language. You can select multiple
languages. You can toggle between languages by clicking on the language system tray icon.

Regional Settings
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Security

The Security dialog box allows you to control various terminal functions related to security and terminal
operator accounts.

Enabling Security

System security is enabled by default, which forces users to log in if the automatic login feature is not
enabled.

● Select Lock screen when pressing Ctrl+Alt+Delete to allow users to lock the terminal
through the Ctrl+Alt+Delete keyboard command.

● Select Automatic Log On to bypass the need for the user to enter a password to log in. This
also activates the Single Button Log On check box and Account list.

◦ Select Single Button Log On to enable the single button connect feature, which invokes a
dialog box that requires the terminal operator to press a keyboard key or click the Logon
button on the dialog box to log in.

◦ In the Account list, select the account that the terminal will use to log in user. For information
about creating a new account, see Creating a User Account on page 57.

Select Enable Reset Hotkey if you want to allow users to reset the terminal to factory defaults
(registry and shortcuts) by pressing and holding the F9 key during boot.

56 Chapter 4   Control Panel



Creating a User Account

To create a new security account for a terminal operator, select the Users tab on the Security dialog
box. This tab lists all the operator accounts and shows which accounts are set up with Administrator
security privileges and which accounts are enabled.

For more information about creating user accounts, see Creating User Accounts on page 8 in Chapter
3.

SNMP
You can manage the terminal through standard third-party simple network management protocol
(SNMP) tools. The SNMP Network Administration dialog box allows you to enter parameters required
for SNMP management.

SNMP agents run in network elements and respond to Network Management Station (NMS) queries
(GETs). SNMP provides a means to query all terminals assigned to a specific community. Each
community should have a unique name, and all members of a community have the same access
privileges. You can assign a single terminal to multiple communities.

Agents send unsolicited reports (traps) back to a specified IP address when a particular network activity
occurs. The following traps are supported: cold start, warm start, authentication failure, link down, and
link up.

To add a new community:

1. Click the Agent tab.

2. In the Traps section, click Add Community.

3. Type the new community name, and then click OK.
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To add and assign rights to an accepted community:

1. Click the Security tab.

2. Click Add in the Accepted Community Names section. The Community Configuration dialog
is displayed.

3. Type the name of the community in the Community Name box.

4. Select the rights to the community in the Rights list, and then click OK.
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To add SNMP packets:

1. Click the Security tab.

2. Select Accept SNMP Packets from these hosts.

3. Click Add in the SNMP packets section. The SNMP Configuration dialog is displayed.

4. Type the host name or IP address, and then click OK.

5. Repeat steps 1 and 2 to add more hosts.

SNMP
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To configure SNMP:

1. On the Agent tab, type the physical location of the terminal in the Location box.

2. Type the name of the contact person responsible for the terminal in the Contact box.

3. Assign the terminal to a community by selecting a community from the Community Name list.

4. To add a trap destination:

a. In the Trap Destinations section, click Add. The SNMP Configuration dialog is displayed.

b. Type the host name or IP address of the NMS trap server, and then click OK.
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5. If you want to add or change SNMP security settings, click the Security tab.

6. To enable an authentication failure trap, select Enable Authentication Failure Trap.

7. Select the hosts from which SNMP packets may be accepted. Choose either Accept SNMP
packets from any host or Accept SNMP packets from these hosts.

8. Click OK after entering all the necessary SNMP information.
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SNTP Client

The SNTP dialog box allows administrators to synchronize the clocks on all thin clients. Administrators
can set thin clients to automatically synchronize with an Internet time server or with a boot server.

Synchronization can occur only when your computer is connected to the Internet.

NOTE: This feature can generate significant network traffic.
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System
The System Properties dialog box allows you to view manufacturer and product information, network
settings, and copyright information. You can also reset the terminal to default factory settings, adjust the
memory allocated for storage and running programs, assign a device name for network identification
purposes, and configure the network card.

The System Properties dialog box includes the following tabs:

● General: Shows manufacturer and product information for the terminal. Includes a Reset button
that you can use to reset the terminal to factory default property settings. It also includes Export
and Import buttons for easy registry import/export . For more information, see Copying Registry
Settings on page 64.

● Memory: Allows you to adjust memory allocation between memory for storage room and
memory needed to run programs.

● Network: Allows you to designate a device name and description that identifies the terminal
across the network. You can type a name or accept the name provided by the DHCP server. The
default device name is “HP” followed by the MAC address. If the device is reset to factory
defaults, the device name reverts to the factory default name.

This tab also shows network settings and provides a Configure Network Card button that
allows you to adjust the speed/duplex for the card.

The Renew button renews the terminal IP address.

● Copyrights: Shows copyright information for the terminal.
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Resetting Settings to Factory Defaults

To reset all thin client settings to factory defaults:

1. Click the General tab.

2. In the Terminal Settings section, click Reset.

3. Click Yes to reset the terminal to factory settings. The terminal restarts.

● The default for File Server is 161.

● The default for Path and Filename is 162.

Copying Registry Settings

You can copy and transfer the registry settings from one thin client to another. Also known as “ARP”,
this feature allows you to configure a thin client and then transfer that configuration to multiple other
thin clients. To clone an entire thin client image, you must first update the image, and then transfer the
registry files.

You can transfer registry settings on only “like-to-like” clients, meaning that the thin client you transfer to
must have the same of the following list as the thin client you transfer from.

● model number

● build number

● add-ons

To transfer registry settings to one thin client:

NOTE: You can use Altiris or FTP to transfer registry settings to multiple thin clients.

1. Configure a thin client to your specifications.

2. In Control Panel > System > General tab, in the Terminal Settings section, click Export.

3. Navigate to where you want to save the settings file. You can save the file to the hard drive, a
network drive, a USB drive key, etc. After you give the file and name and click OK to save the
file, it can take up to five minutes for the file to save.

4. After exporting the registry settings file, from the thin client to update, go to Control Panel >
System > General tab, and in the Terminal Settings section, click Import.

5. Navigate to where you exported the settings file, select the file, and then click OK. You must
restart the client for the new settings to take effect.

NOTE: The registry settings file does not include desktop shortcuts.

For more information about exporting registry settings, see Chapter 6, Registry Import/Export
on page 82.
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System Update

The System Update dialog box allows you to define the means by which you update the terminal
image. The feature updates only the operating system, the BIOS is not updated. You can update the
image:

This tab allows you to automatically update the image by having the DHCP server provide the location
of the file server on which the upgrade files are located. This feature provides an alternative to Altiris
for image deployment.

● Directly from HP by manually entering HP FTP file server information for the server that contains the
update.

● By allowing the DHCP server to locate the FTP file server that contains the update.

NOTE: For more information on setting DHCP values, refer to the “DHCP Options” section in this
chapter.

You may want to update your image because of the following:

● You receive a new client, perform updates to the client image, and decide you want to revert to
the “good, known” image.

● An image gets corrupted and the client requires re-imaging.

● Your client image is old and you want the newest available stable image.

CAUTION: Turning off the power before the update is complete may corrupt the flash memory on the
terminal.

System Update
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For information about automatically updating your client, see the related white paper at:
http://h20000.www2.hp.com/bc/docs/support/SupportManual/c00448549/c00448549.pdf.

To update the image using the DHCP server:

1. From the Server type list, select either FTP or Network Share.

2. In the Host box, type the name of the host box.

3. In the Path box, type the path. If you selected FTP from the Server type list, you must also type
the port number in the box to the right of the Path box.

4. In the User ID and Password boxes, type the user ID and password required by the FTP file
server.

5. If you selected Network Share from the Server type list, in the Domain box, type the
network location.

6. Select Check for updates at startup to cause the unit to check the entered FTP site for
software updates.

7. Click Connect to connect to the server you configured in the previous steps. The Connect button
is not available until you enter valid information for the server.

8. Select Use Values from DHCP Server.

9. In the Server Name/IP box, type the FTP Server Name/IP.

10. In the Path and Filename box, type the path and file name of the image.

11. In the Server Port box, type the FTP server port.

12. In the User ID and Password boxes, type the user ID and password required by the FTP file
server.

13. To automatically update the image each time the terminal is restarted, select Automatically
check for updates on startup. This feature allows you to place a single, updated image on
an FTP site and have clients automatically check that site at boot-up and update with the new
image.

14. Click Update to begin the update process.

The DHCP Options dialog allows you to set the DHCP tags that identify the FTP location of the update
image.

To change the FTP option IDs, type over the entry in the Server Port box, and then click OK. The
value must match what is set up on the DHCP server.

Terminal Server Client Licenses

The Terminal Server Client Licenses dialog box allows you to view stored licenses. You can use this
window to delete or save licenses.

66 Chapter 4   Control Panel

http://h20000.www2.hp.com/bc/docs/support/SupportManual/c00448549/c00448549.pdf


ThinPrint
ThinPrint can be used for ICA/RDP sessions, provided a TCP/IP connection exists between server and
client. For more information, see ThinPrint on page 71.

View or Remove Programs

The View or Remove Programs dialog box allows you to view or remove software programs currently
installed on the terminal.

To remove a program, select the program from the list and click Remove.

VNC Server

Virtual Network Computing (VNC) is a remote control program that allows you to view and interact
with one computer (the “server”) using a simple program (the “viewer”) on another computer anywhere
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on the Internet. The VNC Server runs as a service and therefore is available even when the user is
logged off the thin client.

68 Chapter 4   Control Panel



Settings for VNC Server

Configure VNC Server on your thin client by selecting the following:

Check Box Explanation

Prompt local user to accept incoming
connections

The default should be ENABLED and Auto Accept should be ENABLED

Enable Viewer Cursor This setting allows the viewer to show its cursor on the screen while moving the
mouse. The viewer shows a small dot that points to the actual location of the “hot
spot” of the remote cursor location. Enabling this setting will show the local cursor
of the viewer; however, the remote dot will lag behind the local viewer cursor as it
tries to synchronize the local viewer cursor.

Accept input events from clients Enabling this setting will allow the viewer to control the keyboard and mouse of the
unit remotely.

Autoport Select This setting will be devalued, leaving only the “Accept connections on port” and
“Allow HTTP connections on port”.

Accept connections on port Defaults to the standard VNC port of 5900.

Allow HTTP connections on port Defaults to the standard VNC port of 5800 for JVM (Java)-enabled Web Browser
Viewers.

NOTE: Windows CE does not support Java.

You can find additional information about VNC Server features at: http://www.realvnc.com/
documentation.html.

Volume and Sounds
The Volume & Sounds Properties dialog box allows you to adjust the volume setting and enable sounds
for various events and conditions. You can also create custom sound schemes for various events.
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5 Programs and Add-ons

This chapter provides detailed information about programs and add-on programs for the CE 5.0
image. You can download add-ons from the HP Support Web site.

Add-ons are programs that you can add and remove from a thin client. Add-ons consist of both
programs that come with the default thin client image, and programs that you can add.

The following table provides a list of Add-ons and whether they are included in the image:

Add-On In Factory
Image

CE 6.0  Add-On In Factory
Image

CE 6.0

Aclient for CE
6.0

Y Y  TEC 5.0 Y Y

HP Easy Tools Y Y  HP ThinConnect

ThinPrint

Y Y

ICA 10.x Y Y  HP ThinState Y Y

Internet
Explorer 6.0
for 6.00

Y Y  TxtPad Y Y

JetCet 5.2 for
6.00

Y Y  Universal SC Reader Y Y

Keyboard Intl Y Y  USB Mass Storage 6.0 Y Y

Media Player
9.0 for 6.00

Y Y  USB Parallel Port for
6.0

Y Y

RDP 6.0 Y Y  USB Wireless for 6.0
(VIA)

 Y

SNTP Client
6.0

Y Y  Win Explorer Y Y
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Programs

File Viewers

The following steps demonstrate how to view files created in Microsoft Office Excel, Office PowerPoint,
and Office Word.

NOTE: This feature allows read access only.

1. To open File Viewers, click Start > Programs > File Viewers.

2. Click the desired application viewer to open it.

3. Browse to the file you want to view and select it.

ThinPrint

The following steps illustrate how to set up ThinPrint over TCP/IP. ThinPrint can also be used for ICA/
RDP sessions, provided a TCP/IP connection exists between server and client. You must set up ThinPrint
on the server before attempting any ThinPrint jobs. For more information about how to set up the server,
see http://www.thinprint.com.

ThinPrint over TCP/IP

1. Connect a local printer to the thin client.

NOTE: Windows CE assigns LPT1 to the parallel port and LPT2 to the USB port.
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2. Open ThinPrint by selecting the icon on the Windows task bar or by clicking Start > Programs
> ThinPrint.

3. Click the Assignment tab to set up the printer. The default printer name and port appear as
LPT1:LPT1.
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4. Click Add local port to enter a new printer name and port; for example, HP_LaserJet_1150.
You can change the printer name by selecting the printer and clicking the Edit entry button.

5. Select the printer you just created.

6. Click OK to close the ThinPrint screen.

7. Reopen ThinPrint.
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8. Select the printer you created from the Current printer list.

9. Click OK to save settings.

10. Create an ICA or RDP connection in HP ThinConnect.

11. Double-click on the connection you just created.

12. Log in to the server.
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13. Open a any Word document and click File > Print.

14. Select the printer from the list. The display format is printer name#computer name. (For
example, hp_LaserJet_1150#HP000AE495D355:1)

15. Click OK to print the document.

ThinPrint Network Printer

1. Open ThinPrint.

2. Click the Assignment tab, and then click the Add Network Printer button.

3. If configuring a shared printer:

a. Select Shared printer.

b. Type the Printer name.

c. Type the Network path, User name, and Password.
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NOTE: The printer name must match the printer name set up on the server.

4. If configuring an LPD Printer:

a. Select LPD Printer.

b. Type the Printer name.

c. Type the printer’s IP address in the Printer address field.

NOTE: The printer name must match the printer name set up on the server.

5. Click OK to save settings and close the Network Printer window.

6. On the Assignment tab, select the check box next to the printer you just set up.

7. Click OK to save settings and close ThinPrint.
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8. Open ThinPrint and select the printer you just added from the drop-down list.

9. Log in to ICA or RDP.

10. Open any Word document. and then select Print.

11. Select the printer from the list.

12. Select OK to print the document.

HP Connections for Citrix Software

The HP Connections for Citrix Software window provides a quick and easy means of creating new ICA
connections. You can also delete and edit connections, as well as create desktop shortcuts for
connections.

NOTE: Any ICA connection created will appear in both the HP ThinConnect window and the HP
Connections for Citrix Software window. For more information about HP ThinConnect , see Chapter 3,
HP ThinConnect on page 6.

You can access the HP Connections for Citrix Software window from:

● Start > Programs > HP Connections for Citrix Software.

● The shortcut icon on the desktop.

Creating a New ICA connection

The upper section of the window contains the ICA connection.
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To create a new connection:

1. Double-click the icon in the top section.

or

2. From the File menu, highlight New Connection and select the type of connection you want to
make. Follow the instructions in the Wizard or dialog.

Deleting a Connection

To delete an established connection:

1. Right-click on the connection and select Delete Connection.

or

Select the connection and press the Delete key.

2. Click Yes to delete the connection.

NOTE: Deleting a connection through HP Connections for Citrix Software also deletes the connection
from HP ThinConnect.

Editing a Connection

To edit an established connection:

1. Right-click on the connection and select Edit Connection.

2. Modify the connection.

Creating a Desktop Shortcut to a Connection

You can create a shortcut to a connection on the desktop through HP Connections for Citrix Software.
You cannot create shortcuts through HP ThinConnect.

To create a shortcut, right-click on the connection and select Send to Desktop.

RDP 6.0

Remote Desktop Protocol (RDP) 6.0 replaces RDP 5.5 and provides the following functionality:

● Unicode compatibility, which enables you to send Unicode values of characters as virtual key
codes to the keyboard input.

● RDP supports operation in any environment that allows network localization, automatic disconnect,
and remote configuration.

● Variable bandwidth allocation through client-side bitmap caching and optional compression for
low-bandwidth connections, significantly improving performance over low-bandwidth connections.

● Multichannel-capable protocol that permits separate virtual channels for carrying presentation
data, serial-device communication, licensing information, and heavily encrypted data.
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● Remote control which lets the support staff view and control a Terminal Services session. Sharing
input and display graphics between two Terminal Services sessions lets support staff diagnose and
resolve problems remotely.

● Network Load Balancing (NLB), available in Windows 2000 Advanced Server and Datacenter
Server.

● High color 16-bit, 24-bit, and 32-bit graphics are supported if they are also supported in the
graphics driver.

● Custom high resolution supports wide screen monitors.

● Clipboard sharing, also known as clipboard redirection. The local clipboard becomes a part of
the clipboard viewer chain in the remote session, allowing the user to copy and paste between
applications running in both the remote session and on the local client.

● Local-printer redirection so server applications can print locally to the client device.

● Local audio playback so server applications can direct audio to the client device or play at the
Terminal Server.

● Local-port redirection so server applications can use parallel and COM ports of the client device.

● Local drive redirection so server applications can use the file system (including ATA) of the client
device.

● File redirection filter that permits exposing only specific directories. If you specify that only external
storage, such as Compact Flash or USB storage, be exposed through the redirected drive,
information is saved only to the redirected drive.

● TS CAL maintenance tool. This control panel window is available in any OS design that supports
Control Panel programs, such as the Enterprise Web Pad. It requires that RDP client be in the run-
time image.

● Server authentication verifies that you are connecting to the correct remote computer or server to
help prevent unintentionally exposing confidential information.

● Transport Layer Security (TLS)/Secure Sockets Layer (SSL) protects users from rogue servers.

● Network level authentication requires user level authentication prior to establishing full RDP
connection. This may remove the need for the HP Single Login Button, as this feature allows you to
leave the thin client on the RDP logon screen indefinitely without taking server resources.

RDP runs in Graphics, Windowing, and Events Subsystem (GWES) rather than in its own process
space. This provides faster display updates by reducing the protected server library (PSL) and kernel
overhead. RDP running in GWES can improve performance up to 30%.

NOTE: If you configured RDP to run in GWES, you cannot run RDP inside a Web browser.
Optionally, you can configure RDP to run in Microsoft ActiveX Control.

Terminal Emulation Connection

Terminal Emulation Connection (TEC) allows you to create a terminal emulation session for a terminal.
You can create two different types of TECs, a one-time connection, or a connection associated with a
user account.
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To create a one-time connection:

1. Click Start > Programs > Terminal Emulation.

2. In the Type box select the connection type.

3. Click Configure to configure settings for the connection type you selected.

4. If you selected TCP/IP in the Connect box, click Telnet Options to further configure the
connection.

5. In the Connect To box select the port to which to connect.

6. Click Connect to establish the connection. The Connect button is not available until the
connection is properly configured.

To associate a TEC with a user account:

1. Start > Programs > HP ThinConnect.

2. Click Add.
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3. Select Terminal Emulation, and then click OK.

4. Follow the wizard to configure the connection.

TxtPad

TxtPad is a simple text editor in the Windows CE the image. TxtPad associates with the following file
extensions: .txt, .ini, .log, and .arp.

NOTE: The maximum character limit is 5-MB of ASCII data.

TxtPad is available from a shortcut in the Start > Programs menu.

Add-ons
The following section provides information about add-ons that can be added to your CE-based thin
client image.

ELO Touch Screen

The ELO Touch Screen applet allows you to enable or disable the touch screen. You can also calibrate
the touch screen by clicking the Align button.

Add-ons 81



6 Registry Import/Export

ATTENTION: When deploying an image and settings from a “source” or “master” thin client to a
“target” thin client, please make sure that source/master and target thin clients have identical
hardware. This is applicable regardless of deployment method being used: HP ThinState Tools, Altiris
Deployment Solution, HP OpenView Client Configuration Manager, or any other deployment solution
being used.

This chapter explains how to import/export a thin client registry using Altiris Deployment Server. For
more information about Altiris, see http://www.altiris.com/.

For information about installing an Altiris BootWorks partition, see http://h20000.www2.hp.com/bc/
docs/support/SupportManual/c00215445/c00215445.pdf.

The Registry Import/Export tool is an HP-engineered software technology that makes it significantly
easier and more cost efficient to manage HP thin clients. Registry Import/Export allows thin client
devices to inherit properties of other thin client devices. Extracting the settings of one device and
redeploying the same settings to other devices reduces network congestion. Registry settings can be
100 to 10,000 times smaller than the entire image.

Please note the following about the Registry Import/Export tool:

● The tools requires extensive knowledge of Altiris Deployment Server.

● The source and target machine must have the same image with the same quantity of software add-
ons, and the software add-ons must be of the same revision. The Registry Import/Export Tool
cannot upgrade or downgrade application versions.

● The import/export process may take approximately two minutes to complete.

CAUTION: Currently, Registry Import/Export between the HP t5510 thin client and the HP t53x0 and
t5500 thin clients is not supported.

Clearing the Destination Registry
Before importing a new registry to a thin client, you must clear the destination machine registry. To
clear the registry, drag and drop CE_RegReset from the Job window to the Destination Computer.
Completion of this process takes two to three minutes.
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Exporting and Importing a Registry
To export a registry:

1. Open the Deployment Server Console.

2. Select CE_RegExport from the Job window and drag and drop the Job to the source unit under
the Computers window. This copies the source computer’s registry and prepares it for import.

3. Select CE_RegImport from the Job window and drag and drop the job to the destination
computer under the Computers window. This imports the settings from the source computer to the
destination computer.

Importing a Registry to Multiple Units

You can import a single registry to multiple units. To import a registry to multiple units:

1. Select CE_RegExport from the Job window and drag and drop the Job to the source unit under
the Computers window. This copies the source computer’s registry and prepares it for import.

2. Select CE_RegImport from the Job window and drag and drop the job to “All Computers” under
the Computers window. This imports the settings from the source computer to the network.

Exporting Registries from Multiple Units

While it is possible to export registries from multiple thin clients, it is important to ensure the registry
files have different names. The export process saves a time stamp as part of the name for the saved file
(for example, 051306840.reg, which is May 13, 2006 at 8:40). If you export multiple units at the
same time, the registry file names will be identical. To create distinct file names for each registry, HP
recommends that you capture each registry a minute apart.
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